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Old face
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Beatrice Warde
THE CRYSTAL
GOBLET

You have two goblets before you. One is of solid gold, wrought in
the most exquisite patterns. The other is of crystal-clear glass,

thin as a bubble, and as transparent.

..A1f you have no feelings about wine one way or the other, you will
want the sensation of drinking the stuff out of a vessel that may

have cost thousands of pounds; but if you are a member of that
vanishing tribe, the amateurs of fine vintages, you will choose the
crystal, because everything about it is calculated to reveal rather than

hide the beautiful thing which it was meant to contain.
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Layout & composition
text paragraphs -

RANGE LEFT PREFERRED
range right, centred, justified

12/15 pt Lorem ipsum dolor sit
amet, consectetur adipiscing elit.
Nulla vulputate arcu non aliquam
suscipit. Sed venenatis iaculis
nulla, ac euismod augue ornare
nec. Donec ac enim ac nunc
volutpat porttitor vitae eget tellus.
Phasellus vitae augue semper,
sollicitudin est eget, ultrices
ligula. Curabitur sodales quam

id velit laoreet laoreet. Curabitur

12/15 pt Lorem ipsum
sit amet, consectetur adipiscing
elit. Nulla vulputate arcu non
aliquam suscipit.

Sed venenatis iaculis nulla, ac
esmod augue ornare nec. Donec
enim ac nunc volutpat
porttitor vitae eget tellus.
Phasellus vitae augue semper,
sollicitudin est eget, ultrices
ligula. Curabitur sodales
quam id velit.

12/15 pt Lorem ipsum dolor sit
amet, consectetur adipiscing elit.
Nulla vulputate arcu non aliquam
suscipit. Sed venenatis iaculis
nulla, ac euismod augue ornare
nec. Donec ac enim ac nunc
volutpat porttitor vitae eget tellus.
Phasellus vitae augue semper,
sollicitudin est eget, ultrices
ligula. Curabitur sodales quam

id velit laoreet laoreet. Curabitur

12/15 pt Lorem ipsum dolor sit
amet, consectetur adipiscing elit.
Nulla vulputate arcu non aliquam
suscipit. Sed venenatis iaculis nulla,
ac euismod augue ornare nec.
Donec ac enim ac nunc volutpat
porttitor vitae eget tellus. Phasellus
vitae augue semper, sollicitudin
est eget, ultrices ligula. Curabitur
sodales quam id velit laoreet
laoreet. Curabitur mi mauris,
dictum in feugiat nec, rutrum eget



Typo-graphic design principles
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Layout & composition
leading/line spacing
& line length

MINIMUM LINE LENGTH
approx 30 characters
for text paragraphs

12/14 pt Lorem ipsum dolor sit
amet, consectetur adipiscing elit.
Nulla vulputate arcu non aliquam
suscipit. Sed venenatis iaculis
nulla, ac euismod augue ornare
nec. Donec ac enim ac nunc
volutpat porttitor vitae eget tellus.
Phasellus vitae augue semper,
sollicitudin est eget, ultrices
ligula. Curabitur sodales quam

id velit laoreet laoreet. Curabitur

12/15 pt Lorem ipsum dolor sit
amet, consectetur adipiscing elit.
Nulla vulputate arcu non aliquam
suscipit. Sed venenatis iaculis
nulla, ac euismod augue ornare
nec. Donec ac enim ac nunc
volutpat porttitor vitae eget tellus.
Phasellus vitae augue semper,
sollicitudin est eget, ultrices
ligula. Curabitur sodales quam

12/16 pt Lorem ipsum dolor sit
amet, consectetur adipiscing elit.
Nulla vulputate arcu non aliquam
suscipit. Sed venenatis iaculis
nulla, ac euismod augue ornare
nec. Donec ac enim ac nunc
volutpat porttitor vitae eget tellus.
Phasellus vitae augue semper,
sollicitudin est eget, ultrices
ligula. Curabitur sodales quam

id velit laoreet laoreet. Curabitur
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Layout & composition
leading/line spacing
& line length

12/14 pt Lorem ipsum dolor sit amet, consectetur
adipiscing elit. Nulla vulputate arcu non aliquam suscipit.
Sed venenatis iaculis nulla, ac euismod augue ornare nec.
Donec ac enim ac nunc volutpat porttitor vitae eget tellus.
Phasellus vitae augue semper, sollicitudin est eget, ultrices
ligula. Curabitur sodales quam id velit laoreet laoreet.
Curabitur mi mauris, dictum in feugiat nec, rutrum eget
nisl. Cras suscipit hendrerit nunc, congue tristique sapien
fermentum ac. Vivamus odio sem, fringilla sed quam ac,
imperdiet congue arcu. Proin consequat ipsum ac venenatis
ultricies. Donec pellentesque augue in aliquet pretium.

12/15 pt Lorem ipsum dolor sit amet, consectetur
adipiscing elit. Nulla vulputate arcu non aliquam suscipit.
Sed venenatis iaculis nulla, ac euismod augue ornare nec.
Donec ac enim ac nunc volutpat porttitor vitae eget tellus.
Phasellus vitae augue semper, sollicitudin est eget, ultrices
ligula. Curabitur sodales quam id velit laoreet laoreet.
Curabitur mi mauris, dictum in feugiat nec, rutrum eget
nisl. Cras suscipit hendrerit nunc, congue tristique sapien
fermentum ac. Vivamus odio sem, fringilla sed quam ac,
imperdiet congue arcu. Proin consequat ipsum ac venenatis

12/16 pt Lorem ipsum dolor sit amet, consectetur
adipiscing elit. Nulla vulputate arcu non aliquam suscipit.
Sed venenatis iaculis nulla, ac euismod augue ornare nec.
Donec ac enim ac nunc volutpat porttitor vitae eget tellus.
Phasellus vitae augue semper, sollicitudin est eget, ultrices
ligula. Curabitur sodales quam id velit laoreet laoreet.
Curabitur mi mauris, dictum in feugiat nec, rutrum eget
nisl. Cras suscipit hendrerit nunc, congue tristique sapien
fermentum ac. Vivamus odio sem, fringilla sed quam ac,
imperdiet congue arcu. Proin consequat ipsum ac venenatis
ultricies. Donec pellentesque augue in aliquet pretium.



Typo-graphic design principles
and practices

Layout & composition
leading/line spacing
& line length

MAXIMUM LINE LENGTH
approx 65 characters

12/14 pt Lorem ipsum dolor sit amet, consectetur adipiscing elit. Nulla
vulputate arcu non aliquam suscipit. Sed venenatis iaculis nulla, ac
euismod augue ornare nec. Donec ac enim ac nunc volutpat porttitor
vitae eget tellus. Phasellus vitae augue semper, sollicitudin est eget, ultrices
ligula. Curabitur sodales quam id velit laoreet laoreet. Curabitur mi
mauris, dictum in feugiat nec, rutrum eget nisl. Cras suscipit hendrerit
nunc, congue tristique sapien fermentum ac. Vivamus odio sem, fringilla
sed quam ac, imperdiet congue arcu. Proin consequat ipsum ac venenatis
ultricies. Donec pellentesque augue in aliquet pretium.

12/15 pt Lorem ipsum dolor sit amet, consectetur adipiscing elit. Nulla
vulputate arcu non aliquam suscipit. Sed venenatis iaculis nulla, ac
euismod augue ornare nec. Donec ac enim ac nunc volutpat porttitor
vitae eget tellus. Phasellus vitae augue semper, sollicitudin est eget, ultrices
ligula. Curabitur sodales quam id velit laoreet laoreet. Curabitur mi
mauris, dictum in feugiat nec, rutrum eget nisl. Cras suscipit hendrerit
nunc, congue tristique sapien fermentum ac. Vivamus odio sem, fringilla
sed quam ac, imperdiet congue arcu. Proin consequat ipsum ac venenatis
ultricies. Donec pellentesque augue in aliquet pretium.

12/16 pt Lorem ipsum dolor sit amet, consectetur adipiscing elit. Nulla
vulputate arcu non aliquam suscipit. Sed venenatis iaculis nulla, ac
euismod augue ornare nec. Donec ac enim ac nunc volutpat porttitor
vitae eget tellus. Phasellus vitae augue semper, sollicitudin est eget, ultrices
ligula. Curabitur sodales quam id velit laoreet laoreet. Curabitur mi
mauris, dictum in feugiat nec, rutrum eget nisl. Cras suscipit hendrerit
nunc, congue tristique sapien fermentum ac. Vivamus odio sem, fringilla
sed quam ac, imperdiet congue arcu. Proin consequat ipsum ac venenatis
ultricies. Donec pellentesque augue in aliquet pretium.
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Layout & composition
using more than one typeface

MINIMALISM IS GOOD PRACTICE
the fewer typefaces, fonts and sizes
are best practice

Sub or main heading

12/15 pt Lorem ipsum dolor sit amet, consectetur
adipiscing elit. Nulla vulputate arcu non aliquam suscipit.
Sed venenatis iaculis nulla, ac euismod augue ornare nec.
Donec ac enim ac nunc volutpat porttitor vitae eget tellus.
Phasellus vitae augue semper, sollicitudin est eget, ultrices
ligula. Curabitur sodales quam id velit laoreet laoreet.
Curabitur mi mauris, dictum in feugiat nec, rutrum eget
nisl. Cras suscipit hendrerit nunc, congue tristique sapien

Sub or main heading

11/15 pt Lorem ipsum dolor sit amet, consectetur adipiscing
elit. Nulla vulputate arcu non aliquam suscipit. Sed venenatis
iaculis nulla, ac euismod augue ornare nec. Donec ac enim ac
nunc volutpat porttitor vitae eget tellus. Phasellus vitae augue
semper, sollicitudin est eget, ultrices ligula. Curabitur sodales
quam id velit laoreet laoreet. Curabitur mi mauris, dictum in
feugiat nec, rutrum eget nisl. Cras suscipit hendrerit nunc,
congue tristique sapien fermentum ac. Vivamus odio sem,
fringilla sed quam ac, imperdiet congue arcu. Proin consequat
ipsum ac venenatis ultricies. Donec pellentesque augue in
aliquet pretium.
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Exeter University
Brand Typefaces

Adobe Caslon Pro

Regular

abcdefghijklmnopqrstuvwxyz
ABCDEFGHIJKLMNOPQRSTUVWXYZ
1234567890 ?@£()%

Italic

abcdefghijklmnopgrstuvwxyz
ABCDEFGHIJKLMNOPQRSTUVWXYZ
1234567890 12@£()%

Bold

abcdefghijklmnopqrstuvwxyz
ABCDEFGHIJKLMNOPQRSTUVWXYZ
1234567890 !*?@£()%

Bold italic

abcdefghijklmnopgrstuvwxyz
ABCDEFGHIJKLMNOPQRSTUVWXYZ
1234567890 12@£()%

Humanist 521 BT

Light

abcdefghijklmnopgrstuvwxyz
ABCDEFGHIJKLMNOPQRSTUVWXYZ
1234567890 N@£()%

Roman

abcdefghijklmnopgrstuvwxyz
ABCDEFGHIJKLMNOPQRSTUVWXYZ
1234567890 "@£()%

Italic

abcdefghijklmnopgrstuvwxyz
ABCDEFGHIJKLMNOPQRSTUVWXYZ
1234567890 I?@£()%

Bold

abcdefghijklmnopqrstuvwxyz
ABCDEFGHIJKLMNOPQRSTUVWXYZ
1234567890 P@£()%
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Recap
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Minimalism
start with as fewer
sizes and fonts

as possible
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Range
left only
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No more
than two typefaces



Typo-graphic design principles
and practices

Avoid
DECORATIVE
fo nts
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No more
than three
sizes & two
typefaces
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HEADING 1
Heading 2

SUB HEADING 1
Sub heading 2

SUB HEADING 3
Sub heading 4

SUB HEADING 5

Sub heading 6

Text, itur sodales quam id velit laoreet laoreet.
Curabitur mi mauris, dictum in feugiat nec, rutrum
eget nisl. Cras suscipit hendrerit nunc, congue
tristique sapien fermentum ac. Curabitur mi mauris,

dictum in feugiat nec, rutrum eget nisl.



Typo-graphic design principles Lorem ipsum dolor sit amet, consectetur adipiscing

and practices elit. Nulla vulputate arcu non aliquam suscipit. Sed
venenatis iaculis nulla, ac euismod augue ornare
nec. Donec ac enim ac nunc volutpat porttitor
vitae eget tellus. Phasellus vitae augue semper,
sollicitudin est eget, ultrices ligula. Curabitur
sodales quam id velit laoreet laoreet. Curabitur mi

m mauris, dictum in feugiat nec, rutrum eget nisl.

S e r I f fo n t Cras suscipit hendrerit nunc, congue tristique
sapien fermentum ac. Vivamus odio sem, fringilla

f r sed quam ac, imperdiet congue arcu. Proin

O p a g e S consequat ipsum ac venenatis ultricies. Donec
pellentesque augue in aliquet pretium.

Of teXt Lorem ipsum dolor sit amet, consectetur
adipiscing elit. Nulla vulputate arcu non aliquam
suscipit. Sed venenatis iaculis nulla, ac euismod
augue ornare nec. Donec ac enim ac nunc volutpat
porttitor vitae eget tellus. Phasellus vitae augue
semper, sollicitudin est eget, ultrices ligula ura bitur
sodales quam id velit laoreet laoreet. Curabitur mi

mauris, dictum in feugiat nec, rutrum eget nisl.

Cras suscipit hendrerit nunc, congue tristique
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Do not
justify text
onh a harrow
measure

Loremipsumdolorsitamet,
consectetur adipiscing
elit. Nulla vulputate arcu
non aliquam suscipit. Sed
venenatis iaculis nulla, ac
euismod augue ornare nec.
Donec ac enim ac nunc
volutpat porttitor  vitae
eget tellus. Phasellus vitae
augue semper, sollicitudin
est eget, ultrices ligula.
Curabitur sodales quam
id velit laoreet laoreet.
Curabitur mi  mauris,
dictcum in feugiat nec,
rutrum eget nisl. Cras
suscipit hendrerit nunc,
congue tristique sapien
fermentum ac. Vivamus
odio sem, fringilla sed
quam ac, imperdiet congue

arcu. Proin  consequat
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Use a grid
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Posters

Where When
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Image
or
headline

Posters
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Reports

Imagine for the main body of the
text you are using a typewriter
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Use colour
sparingly

use colours in a consistent manner
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Palle te
CO I o u r Use the colour palette from

your institution’s guidelines
as a starting point?
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Exeter University
Brand Colours

PANTONE®
430

Recruitment grey
Process colour
C53 M37Y34Kl6

RGB colour
R124 G133 B140

Web colour
#7B858B

PANTONE®
2623

Recruitment purple
Process colour
C73MI100Y24 KI5

RGB colour
R95 G34 B100

Web colour

#5E2263

PANTONE®
314

Recruitment teal
Process colour
C94 MI14Y28KI

RGB colour
RO G147 BI75

Web colour
#0092AF

PANTONE®
16

Recruitment pink
Process colour
CI12MI100 Y49 Kl

RGB colour
R210 GI13 B82

Web colour
#D10D52

PANTONE®
91

Recruitment sky blue
Process colour

C34 M3 YO KO

RGB colour
R178 G220 B247

Web colour
#B2DBF6

PANTONE®
032

Recruitment red
Process colour
COM9I Y100 K2

RGB colour
R226 G48 BI8

Web colour
#EI2FI |

PANTONE®
382

PANTONE®
388

Recruitment green
Process colour
C50MI1YI00K3

RGB colour
R147 G176 B34

Web colour
#92AF2 |

PANTONE®
144

Recruitment lime
Process colour
C29 MO Y100 KO

RGB colour
R202 G212 BOO

Web colour
#CAD400

PANTONE®
7405

Recruitment orange
Process colour
COMSI Y100 K7

RGB colour
R230 G137 B0

Web colour
#E98A00

Recruitment yellow
Process colour
C4MI1 Y97 K2

RGB colour
R247 G214 BO

Web colour
#F7D500
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Reports Don’t reinvent

& leaflets the wheel use
a template
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Business report notebook kit (cover,
binder spine, divider tabs)

Recent

Annual
Report

Y YEAR

Business paper

Business

report (Professional design)

Employee weekly status repart

=

Project status report (Red and Black)

an dosignl

Project status report (Timeless
design)

i [E————

Micresoft Word

Travel expense report form

LaGo

Employee warning notice

Annual report with cover photo
(Timeless desian)

[Type the
document titls]

[

Service report

Business plan

BUSINESS REFORT @

[T¥PE THE
DOCUMENT
TITLE)

ANN
REPORT

Annual report (Timeless design) Business report (Median theme)

[Bindor Cover Title]

replace with

Project communication plan Binder cover

Business [

newsletter

[FYPE THE DOGUSMENT TITLE]

Report (Essential design) Business newsletter

MNUTES

dncument title]
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. Insert Design Layout References Mailings Review i &t Share ~
and pI‘aCtlceS ? : Arial (Body) 1 ] As x| 4| Bp [:ET;E - ; S "E é/ @

4=

HE
Paste . B | T |U |~ abe|X;|x2||l A=2| Al Styles  Styles
> = i _— S |- E 2* q Pane

o0 M HWw-U B = Document2

[TYPE THE DOCUMENT TITLE]

[TYPE THE DOCUMENT SUBTITLE]

[Type the abstract of the document here. The abstract is typically a short summary of the
contents of the document. Type the abstract of the document here. The abstract is typically a
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have a report
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template?
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HEADING 1

On the Insert tab, the galleries include items that are designed to
coordinate with the overall look of your document. You can use these
galleries to insert tables, headers, footers, lists, cover pages, and other
document building blocks. When you create pictures, chars, or
diagrams, they also coordinate with your current document look.

Heading 2

You can easily change the formatting of selected text in the document
text by choosing a look for the selected text from the Quick Styles
gallery on the Home tab. You can also format text directly by using the
other contrals on the Home tab. Most controls offer a choice of using
the look from the current theme or using a format that you specify

directly.

To change the overall look of your document, choose new Theme
elements on the Page Layout tab. To change the looks available in the
Quick Style gallery, use the Change Current Quick Style Set command.
Both the Themes gallery and the Quick Styles gallery provide reset
commands so that you can always restore the look of your document to
the original contained in your current template.

HEADING 3

On the Insert tab, the galleries include itemns that are designed to
coordinate with the overall look of your document. You can use these
galleries to insert tables, headers, footers, lists, cover pages, and other
document building blocks. When you create pictures, charts, ar
diagrams, they also coordinate with your current document look.
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Tone of voice?

Academic & authorative?
Accessible to a lay audience
- simple, clear & authorative?

- simple, clear & friendly?

Edit and distill the message
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Edit and distill
the message

Tone of voice

clear separation between headings _
succinct and conscise wording
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Re cap

Use a grid and/or template

Use your institutions typefaces
- serif & sans serif

Start with the institutions
colour pallete

Investigate your institutions
image bank

Editing and distilling the message
is key
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Workshop

Any questions from semninar?
Brief example of flyer

Design police stickers

crit and discuss some existing

examples of graphic design

Design simple posters
using your text descriptions
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Brief example of flyer

-reative Communication: Typo-Graphic Design principles and practice

11:00 — 12:30 (optional workshop 14:00-16:00) on Tuesday, 24t Oct 2017 Room
SC3.06, South Cloisters, St Luke’s Campus
(Video link to Truro Knowledge Spa F08 and Plymouth John Bull Building MR10)

As part of the 'Creative Communication: seminar and workshop series’ Peter Jones
will be talking about his expertise in using typo-graphic design principles and practices
to produce creative and engaging communication pieces such as reports, posters and
leaflets. As well as giving an overview of these useful principles, Peter will also
highlight how these principles can be used in conjunction with organizational Visual
Identity Guidelines and how these can be more usefully interpreted when designing
creative communications.

The workshop will look at and discuss how researchers may use and/or interpret their
organisation's guidelines (instead of trying to reinvent the wheel) to develop and design
professional and creative communications for particular target audiences.

Peter Jones is the Joint Programme Leader MA Publishing, Strand Coordinator MA
Publishing for Editorial Design Year 2 and Coordinator of the BA Hons Graphic
Communication with Typography at the University of Plymouth........

Look here http://clahrc-peninsula.nihr.ac.uk/creative-communication-seminar-series

for further information on this or other seminars in this series or contact r.s.whear@exeter.ac.uk.
To register click here

Parking at St Luke’s is extremely limited and restricted to University of Exeter permit holders. Parking
attendants patrol regularly. Where possible, please consider alternative options when planning your
visit.

UNIVERSITY OF

National Institute for EXETER
Health Research

MEDICAL
SCHOOL




-reative Communication: Typo-Graphic Design principles and practice

11:00 — 12:30 (optional workshop 14:00-16:00) on Tuesday, 24th Oct 2017 Room
SC3.06, South Cloisters, St Luke’s Campus
(Video link to Truro Knowledge Spa F08 and Plymouth John Bull Building MR10)

As part of the 'Creative Communication: seminar and workshop series’ Peter Jones
will be talking about his expertise in using typo-graphic design principles and practices
to produce creative and engaging communication pieces such as reports, posters and
leaflets. As well as giving an overview of these useful principles, Peter will also
highlight how these principles can be used in conjunction with organizational Visual
Identity Guidelines and how these can be more usefully interpreted when designing
creative communications.

The workshop will look at and discuss how researchers may use and/or interpret their
organisation's guidelines (instead of trying to reinvent the wheel) to develop and design
professional and creative communications for particular target audiences.

Peter Jones is the Joint Programme Leader MA Publishing, Strand Coordinator MA
Publishing for Editorial Design Year 2 and Coordinator of the BA Hons Graphic
Communication with Typography at the University of Plymouth........

Look here http://clahrc-peninsula.nihr.ac.uk/creative-communication-seminar-series

for further information on this or other seminars in this series or contact r.s.whear@exeter.ac.uk.
To register click here

Parking at St Luke’s is extremely limited and restricted to University of Exeter permit holders. Parking
attendants patrol regularly. Where possible, please consider alternative options when planning your

visit.
National Institute for E ETER ?CE ;3 'c% t
Health Research

Creative Communications
Typo-graphic design principles

and practices

Tuesday 24 Oct 2017
1.00 — 14:30
optional workshop
14:30-16:30

Room SC3.06
South Cloisters
St Luke’sCampus
Exeter

Video link

Truro Knowledge Spa F08
and Plymouth John Bull
Building MR10

Parking

Parking at St Luke’s is
extremely limited and
restricted to University

of Exeter permit holders.
Parking attendants patrol
regularly.

Where possible, please
consider alternative options
when planning your visit.

As part of the 'Creative Communication: seminar and
workshop series’ Peter Jones will be talking about his
expertise in using typo-graphic design principles and
practices to produce creative and engaging
communication pieces such as reports, posters and
leaflets. As well as giving an overview of these useful
principles, Peter will also highlight how these
principles can be used in conjunction you're your
organisations Visual Identity Guidelines and how
these can be used in a positive way when designing
creative communications.

The workshop will look at and discuss how
researchers may employ and/or interpret their
organisation's guidelines (instead of trying to reinvent
the wheel) to develop and design professional,
creative and functional communications for particular
target audiences.

Peter Jones Joint Programme Leader MA Publishing,
and lecturer on BA Hons Graphic Communication
with Typography at the University of Plymouth.

Look here
http://clahrc-peninsula.nihr.ac.uk/creative-
communication-seminar-series

For further information on this or other seminars in this
series or contact r.s.whear@exeter.ac.uk.
To register click here

UNIVERSITY OF

EXETER

st (I
National Institute for
Health Research
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Cheesy typeface

lllustrator required

Poor line spacing

Where’s the headline

Legible from space

Microscope required
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Clichéd type effect

(R)

Design Police are
operating in this area

(R)

Design Police are
operating in this area

(R)

Design Police are
operating in this area
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Design a simple poster

24 - 28 October 2017

For a Public Exhibition of
South West, Medical and Scientific
Research

Your short text descriptions of
your research

Exeter University, South Cloisters,
St Luke’s Campus, Exeter, UK



